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Official OJS 3 resources  
The Public Knowledge Project team (PKP), who manage and develop OJS, have produced a user 
guide and two online courses on OJS 3, which you can access by clicking on the headings below. 
Links to sections of the guide and videos from the courses are provided where appropriate in the rest 
of this document. 

Online guide to OJS 3 
Comprehensive online guide to OJS 3. Use the left-hand menu to navigate to specific sections. 

Setting up a journal in OJS 3 (online course) 
Video-based online course that walks you through the new reader interface and most sections of the 
administration dashboard (editorial interface), e.g. how to configure the journal's editorial workflow, 
how to change the way the site looks and operates, how to view and update journal details, editorial 
team information, sections, etc. 

Editorial Workflow in OJS 3 (online course) 
Video-based online course that presents how OJS can be used to manage the full editorial process, 
from submission to online publication. 

  

Please note 
− Some of the material used in these resources is based on earlier releases of OJS 3 and does 

not cover some features that are available now. 

− The two online courses are self-paced and free of charge. To access them, you will need to 
register with PKP School.  

 

http://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
https://pkp.sfu.ca/about/
https://docs.pkp.sfu.ca/learning-ojs/en/
http://pkpschool.sfu.ca/courses/setting-up-a-journal-in-ojs-3
http://pkpschool.sfu.ca/courses/editorial-workflow-in-ojs-3/
http://pkpschool.sfu.ca/register/
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Overview of the OJS 3 dashboard 
OJS 3 has a dashboard, a separate interface for users who are logged into the editorial system. The 
dashboard can be accessed from the login/user menu that appears in the top right corner of every page.  

 

The dashboard consists of the following elements: 

1. Top navigation bar: To the left, you will find the name of the journal you are currently 
working with. If you are enrolled in more than one journal, you can use this to switch between 
journals. Next to that are your Tasks (items needing immediate attention). To the right, you 
can switch languages if the journal is multilingual, view the reader interface, or click on your 
username to view your profile or logout.  

 

2. Left menu panel: These are the major sections of the dashboard, including submissions, 
issue management, settings, user and role management, and tools. Note: Users with fewer 
permissions (e.g. Authors, Reviewers, Copyeditors, etc.) will see fewer links here. 

 

http://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
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3. Main panel: In the main panel you will see the current work area. In the image below, you can 

see a submission record in the Submission stage. 

 

4. Main panel sub-menus: Within the Main Panel, you will often see tabs that allow you to view 
different information about the content being worked on. In this example, you can see the 
four sections of a submission record (Submission, Review, Copyediting, Production).  

 

5. Right panel: From here you can see the action buttons, such as Schedule for Publication. 
Different pages have different action buttons. In this example, below the action buttons is the 
Participants table, which lists everyone (except Reviewers, in the case of blind peer review) 
involved in the submission. 

 

http://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
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6. Blue navigation bar: These menu choices are specific to the different sections of the editorial 
workflow. Metadata, Editorial History, and Submission Library are all part of the submission 
record visible below. 

 
 

7.  Help tab: The Help tab appears on every page and provides context-sensitive help. 

 
 

8. Blue arrows:  You can click on the blue arrows to reveal more information about an item on 
the dashboard. 

 
 

9. Tasks menu:  Click to view a list of items that need your attention. 

 
  

http://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
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Journal and website management 
Edinburgh University Library will do the initial journal and website setup for all journals that use the 
hosting service, but the summaries and links below may be helpful in the day-to-day management of 
your journal and its OJS website.  

Edit basic journal information 
View and update journal details (e.g. title, ISSN, editorial team listing), contact information, and table 
of content sections (e.g. Editorial, Research Articles, Book Reviews). 

Path:   OJS admin dashboard > Settings > Journal > navigate to the relevant tab 

PKP videos: Add journal details – Masthead tab 
Add contact information – Contact tab 
Create sections for tables of contents – Sections tab 

PKP guide:  Chapter 5: Journal Settings  

Update the website 
Change how the site looks and operates, e.g. update homepage text, create announcements, create 
and edit static pages, activate plugins, including the Custom Block plugin, and all other blocks that 
appear on the sidebar in the reader interface. 

Path:   OJS admin dashboard > Settings > Website > navigate to the relevant tab 

PKP videos: Customise website appearance – Appearance tab  
Create and publish announcements – Announcements tab 
Add custom content to the sidebar of the website – Custom Block plugin 
Edit information for Readers, Authors and Librarians – Information tab 
Turn OJS features on/off – Plugins tab  

PKP guide:  Chapter 6: Website Settings  

Configure the editorial workflow 
Update the setup of the journal's editorial workflow, e.g. change peer-review options, update the 
submission guidelines for authors, select permitted article components (e.g. article text, datasets, 
multimedia files), create and edit email templates. 

Path:   OJS admin dashboard > Settings > Workflow > navigate to the relevant tab  

PKP videos: Edit submission guidelines, checklist and form – Submission tab  
Set up peer-review guidelines, default deadlines and forms – Review tab 
Manage emails and automatic notifications – Emails tab 
Edit list of permitted article components – Components tab 
Add commonly-used files to the Publisher Library 

PKP guide:  Chapter 7: Workflow Settings  

http://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
https://www.youtube.com/watch?v=Nky6zy-3b1M
https://www.youtube.com/watch?v=P44fvQe7hO0
https://www.youtube.com/watch?v=0PeTd90a_4w
https://docs.pkp.sfu.ca/learning-ojs/en/journal-setup
https://www.youtube.com/watch?v=DdRy8s2t5OU
https://www.youtube.com/watch?v=GwnA53Irddw
https://www.youtube.com/watch?v=jYQ17KbaRt4
https://www.youtube.com/watch?v=KQ9ybGulGic
https://www.youtube.com/watch?v=OyANMyUmBug
https://docs.pkp.sfu.ca/learning-ojs/en/settings-website
https://www.youtube.com/watch?v=L3kuBM-rrOA
https://www.youtube.com/watch?v=uoz1yhFeKBQ
https://www.youtube.com/watch?v=nmPIeLIUNdQ
https://www.youtube.com/watch?v=KVjAdnCn5Fg
https://www.youtube.com/watch?v=450Ffn4_QdI
https://www.youtube.com/watch?v=450Ffn4_QdI
https://docs.pkp.sfu.ca/learning-ojs/en/settings-workflow
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Manage users and roles 
Create, edit and delete users and user roles, and assign roles to users.  

Path:  OJS admin dashboard > Users and Roles > navigate to the relevant tab   

PKP videos: Create and manage user accounts, and assign roles – Users tab 
Create and manage user roles – Roles tab 

PKP guide:   Chapter 3: User Accounts and Chapter 10: Users and Roles 

Generate reports 
Generate usage statistics, reports on peer-review activity and custom reports, and export a list of all 
articles in the journal. 

Path:  OJS admin dashboard > Tools > Statistics  

PKP video: Generate usage statistics and other reports – Statistics module 

PKP guide:   Chapter 11: Tools > Report Generator 
 

  

http://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
https://www.youtube.com/watch?v=nvZTYotf5bk
https://www.youtube.com/watch?v=Ay3j4kJMwDU
https://docs.pkp.sfu.ca/learning-ojs/en/user-accounts
https://docs.pkp.sfu.ca/learning-ojs/en/users-and-roles
https://www.youtube.com/watch?v=KNrWriOLLkA
https://docs.pkp.sfu.ca/learning-ojs/en/tools#report-generator
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Using OJS for the full editorial workflow 
OJS can be used to manage the entire editorial process from submission to online publication. In the 
OJS 3 admin interface, the editorial workflow is divided into four stages: Submission, Review, 
Copyediting and Production, after which the submission can be published online. Editors can skip 
stages if they are not applicable or have been completed externally. 

Path:  OJS admin dashboard > Submissions  

PKP video: Overview of editorial workflow  

PKP guide:   Chapter 14: Editorial Workflow 

Submission 
View details of a submission, assign it to an Editor, and respond to the author. 

Path: OJS admin dashboard > Submissions > Unassigned tab or All Active tab > find and 
click on submission to go to the submission record > Submission tab  

PKP video: How authors make a submission 
Check and respond to a submission 

PKP guide:   Chapter 14: Editorial Workflow > Submissions 

Review 
Release a submission for peer review, manage the peer-review process, and accept/reject submissions.  

Path: OJS admin dashboard > Submissions > All Active tab > find and click on 
submission to go to the submission record > Review tab  

PKP video: Release a submission for peer review and assign a reviewer 
How reviewers complete a review 
Check review, respond to reviewers and authors, request revisions, and record decision  

PKP guide:   Chapter 14: Editorial Workflow > Review 

Copyediting 
Assign a copyeditor, and send and receive files.  

Path: OJS admin dashboard > Submissions > All Active tab > find and click on 
submission to go to the submission record > Copyediting tab   

PKP video: Overview of copyediting stage 

PKP guide:   Chapter 14: Editorial Workflow > Copyediting 

  

http://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
https://www.youtube.com/watch?v=BLRO0WCRqPg
https://docs.pkp.sfu.ca/learning-ojs/en/editorial-workflow
https://www.youtube.com/watch?v=5ZUlgCS0vEc
https://www.youtube.com/watch?v=ClZmk65QQHM
https://docs.pkp.sfu.ca/learning-ojs/en/editorial-workflow#submission-notifications
https://www.youtube.com/watch?v=iW-ji_ylCKI
https://www.youtube.com/watch?v=NgVxnLror8s
https://www.youtube.com/watch?v=X_E7A3q7mQU
https://docs.pkp.sfu.ca/learning-ojs/en/editorial-workflow#review
https://www.youtube.com/watch?v=Yx3tlufAenU
https://docs.pkp.sfu.ca/learning-ojs/en/editorial-workflow#copyediting
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Production 
Assign a layout editor, upload PDF and/or other galleys, proofread galleys, check metadata, and 
schedule submissions for publication in an issue. 

Path: OJS admin dashboard > Submissions > All Active tab > find and click on 
submission to go to the submission record > Production tab  

PKP video: Overview of production stage and assignment to issue 

PKP guide:   Chapter 14: Editorial Workflow > Production 

Issue management and publication 
Create, manage and publish issues. 

Path: OJS admin dashboard > Issues > Future Issues tab or Back Issues tab 

PKP video: Create and manage issues 

PKP guide:   Chapter 9: Issues 

 

Role-specific guides 
You can share the following guides with reviewers, authors, and the people who do copyediting and 
typesetting work for the journal. 

Guide for authors: 
Submission stage: registering with a journal and submitting an article 
Review stage: responding to a review and resubmitting for review  
After acceptance: responding to a copyediting request and a proofreading request 

Guide for reviewers 

Guide for copyeditors 

Guide for layout editors 

 

http://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
https://www.youtube.com/watch?v=4jwpwV3boKk
https://docs.pkp.sfu.ca/learning-ojs/en/editorial-workflow#production
https://www.youtube.com/watch?v=FbQDrhMNw3M
https://docs.pkp.sfu.ca/learning-ojs/en/issues
https://docs.pkp.sfu.ca/learning-ojs/en/authoring#registering-with-the-journal
https://docs.pkp.sfu.ca/learning-ojs/en/authoring#submitting-an-article
https://docs.pkp.sfu.ca/learning-ojs/en/authoring#responding-to-a-review
https://docs.pkp.sfu.ca/learning-ojs/en/authoring#resubmitting-for-review
https://docs.pkp.sfu.ca/learning-ojs/en/authoring#responding-to-a-copyediting-request
https://docs.pkp.sfu.ca/learning-ojs/en/authoring#responding-to-a-proofreading-request
https://docs.pkp.sfu.ca/learning-ojs/en/reviewing
https://docs.pkp.sfu.ca/learning-ojs/en/editorial-workflow#copyeditor
https://docs.pkp.sfu.ca/learning-ojs/en/editorial-workflow#layout-editing
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